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So You Wrote A Book

Congratulations!

Now there was a time when the companies that published your book would
spend lots of dollars marketing them so that you and they would make money
off of that wonderful work. Those days are gone. The economies, the internet,
books on CD and now electronic readers, have changed all that.

Statistically speaking, the number of people that actually read a book has fallen,
so it is up to the author, as much as the company that publishes to MARKET their
wares. Welcome to the new world of literary art.

Unless you have a huge household name, such as Patterson, Koontz, King, or
have written a little known series such as Harry Potter...not much chance of you
just walking out and saying to folks “I have written a book, perhaps you have
read ite” and them falling before you with awe and wonderment at your
creative genius...even if you are the literary guru of the next thousand years.

So how do you reach such heights¢ Become a household name? Get your
name known in such a way that when you say you have written a book, people
actually “know” you have (other than having a tee shirt that says, “Be careful or
you will end up in my next novell”)2

You become your own literary marketer.

Now before you think you can’t do that. | have put together a little (with some
humor to it so it is not so dry and boring) packet for you new to this. It is FULL of
things that you CAN DO to increase your SKILLS at Marketing YOURSELF and
YOUR WARES, and you will have great fun reading the information as well.

First, let me tell you who | am...I am a short story writer. | am married to a writer,
who lives in a "man cave” and spends literally HOURS marketing himself and his
books. | have not only marketed my stories to magazines, local papers and
radio, but have also advised others how to do the same. | assure you that this
information costs YOU NOTHING...and if you need help along the way, | will be
happy to do so (that may cost you, but we will see).

My name is Dani Eller and welcome to the wonderful world of Marketing Your
Book.



The Basics

[. Where fo start:

Most would think that the start of this was the publishing of the book....wrong.
The GENRE of the book will help with the Marketing. It gives you the beginning
point. What you wrote tells you exactly how you will market it.

Right now the Market is hot for self help and non fiction. Though Sci-fi is always
has loyal followers and true crime is always good, but it is one of those that
depends on who, what and when. If tis a current crime, the topic is hot and
easy to market...if it is an old case...good luck, unless there is a new and exciting
thing to talk about in that area.

If your book is “True Crime”, you could make a list of magazines that have to do
with that and consider sending those excerpts from your book, “teasers” | like to
call them.

If it was a Sci-Fi book you would do the same thing and so on. You can
announce to them when the book is out, where it is available and by what
Publisher. Always give the date, props to the Publisher and mention the cost of
the book, hard cover or paper back, as for some reason this may or may not
make a difference.

This is a first example of how one would do a form of Marketing of their book.
Note some key things here....

1) You need to make a list

2) You need an excerpt from your book

3) You will be giving “KEY INFORMATION" about the book

4) You will be giving Information about the PUBLISHER

And mostimportantly you will be giving the RELEASE DATE of your book.

Let me be VERY clear here: You are going to get this ONE chance to offer up this
work of art to someone that will decide to use this piece you present. To say to
themselves, “Hmm...this author sounds interesting or the book sounds like it would

be something | would read.”

If you send them an excerpt that puts them to sleep, drags or is not eye catching
and BORING....don't count on a response.



Il. Learning about Marketing:

So do you get the first idea here? You are selling your self and your work, by
giving a taste...kind of like the person in the store that stands there and says,
“Here try it” and offers you that little cup of applesauce and a coupon to buy it
in the store somewhere. THAT IS MARKETING.

You are learning how to do that, without leaving your home to take some
$500.00 class.

There a MILLIONS of ways to do this with or without leaving your home, your street
or your town. But | do suggest leaving and getting out in the public eye. That,
however, is another area we will get into. So if you don’t have a nice set of
Sunday wear...get it. Unless your attire and your book is about bondage and you
are going to “Dress the part”....I would suggest being dressed to impress and be
aware that you want to do just that. IMPRESS!

Marketing is easy. It is like anything else on the planet, it fakes commitment and it
takes time. You have to perfect it to your product and to your style.

If you are not up to the task, you will not sell, succeed nor become well known as
an author. It is your choice how well your book will do or not do.

Even the largest of the publishers now require their authors to get involved in the

marketing side of their books. Just as actors promote their movies, now authors
do their books.

It is never a sure thing that your book will sell. Don’t think that because you write
it that it is a hot item right away. Even the best writer's have those ones that they
just thought were great that didn’t sell well.

However, they still sold. Why? Because of how they were marketed. Released to
the public and built up in ways that were made to be great reads, had reviews
made public in a lot of different areas, interest drummed up in them before they
hit the stands, things such as this made them sell. Folks just couldn’t wait to get
their hands on them...and this could be done for you. If you work on the premise

that YOUR book is interesting enough to make people want to read it. It is, isn't
ite

Sure it is! So TELL THEM!!!



Setting up the Media Packet

l. What goes in¢
You will want to put the following things in your media packet:

* Ashort synopsis of your book.
* Make sure it is EYE CATCHING, READ WORTHY and KEEPS THE
READER'S INTEREST BY MAKING THEM WANT MORE!
* You want a picture of yourself (Professional)
 Don’t send a Polaroid picture, take the time to have nice shots
done for media packets. (I suggest the one from the BACK of your
Book itselfl RECOGNITION of name and face.)
* A fewreviews of your book.
* These should be done by other authors. Preferably those that have
been published. *I will tell you how to get these*

Depending on where you are sending the media packet you may want to
include the following as well

* Ashort Biography about yourself.

* Be sure to include how long you have been writing, a little family
back ground (married, kids, dog) and State you are from. Makes
you more approachable.

» List of other published works (magazines, writers shops, online e-zines, etfc.)

* Education is not important UNLESS you are sending to a college or something
in hopes of doing a speaking engagement on the book, then by ALL means,
include it OR if your book is Educational in nature.

Il. What does not go in?

Over time you will learn more about what you can weed in and out,
however...don't send the following. And believe me when | have heard of folks
sending these things and | have wondered “WHY?2!2"

* Polaroid pictures (so tacky)

» TOO LONG OF A SYNOPSIS of their work! (remember a good tease gets them
baited)

* TOO SHORT OF A SYNOPSIS of their work!

* THE ROUGH DRAFT (Good GRAVY!!)

* Did not use correct postage (come on, they will just refuse it)

* Sentit electronically with the wrong file and it wouldn't open (in other words,
do your research and make sure that your files work with theirs!)

They are doing you the favors (in essence) so don’'t make it hard on them. It is



easy fo frash things...you don't want your media packet to be trashed!
lIl. What works and what doesn’te

In the area of experience | will tell you that if you offer a good media packet, it
will be opened and looked at. If the envelope is clean, postage is right and there
is no “sloppy” look to if, they will open it. IF it looks like JUNK MAIL...they will frash
it.

From working in the media, | will tell you what made me open mail sent to the
radio station addressed to me in my department. (Oh, did | forget to mention
thate | chose the current events and human interest stories...ahhh, so that is how
she knows....) Media mail was my thing for over 10 years. If the mail looked like
someone spilled coffee, ate their dinner on it, or had their dog chew it before it
got to me...it was never opened and | threw it away.

| liked it if they:

—_—

KNEW who to address it to.

Had all the information | needed and | called them, so having contact

information was VERY IMPORTANT.

3. lliked letters TYPED. Hand writing was always a peeve of mine. SO TYPE ALL
LETTERS.

4. USE CORRECT POSTAGE. | refused more for not having the correct postage
then anything.

5. Be brief and to the point in your letters of correspondence. Examples will be
provided in this packet.

6. ALWAYS follow up with a letter of thanks if you get the interview or even if you

don't and just want to make sure they got the packet. KEEP YOU ON THEIR

MIND.

™

Keep in mind that the one that “Makes the Noise is heard.” If you are persistent in
sending out your information to the RIGHT people, you will gain entry into the
places you want to be in.

You have to keep your media package current with CURRENT information and
with the things you have accomplished. Have a reading somewhere, add it to
the packet. Did a signinge Add it to the packet. Made a best selling list on
Amazon.com, tell them. This is the RESUME of your success and it tells them about
you and your book. Don't leave out the good stuff, but don't pad it. Keep it redl,
clean and above all, PROFESSIONAL.



Press Releases Made Easy

|. Local Press Releases: A MUST

If you have never thought about this one, think of it now. YOU have to toot your
own horn and this is where it will start.

Get a notebook if you haven't already. Sit at your computer and GOOGLE
Search all Local Newspapers to your area.

This is what you want to look for on Google:

e Local Papers
o Names of the Editors

» Both the “Big Editors and Human Interest Reporters

» Correct addresses

*  You will want them for the fowns Connected to yours. Know
your own comfort level. Where do you want to go and how
far will you go to succeed in the literary field?

= |F the paper is syndicated you will have to do more
research: Find out who owns the paper and their story. IF you
find out the owner was a writer, offer up your story by
relating to him/her. Breaking into the field and giving it back
to those starting out is often a great ICE BREAKER!

You may also do the same for Radio stations and Television stations. Most locall
television satiations have some sort of morning or afternoon programs that do
local interest stories, again, never hurts to try to make a contact or two that may
or may nof result in some local exposure.

Now, you will find in the back of this packet a sample press release. You will go in
and fill out one for every one of those papers on your list,

You want to send with the release a picture. Just a head shot and again, no_
Polaroid.

In your release, be sure to give the pertinent information about yourself and what
you have accomplished. There will be no need for a synopsis of the book. Press
releases should be an announcement of what is coming.

Like announcing the birth of a child, the wedding of a couple, or the promotion
of a life time, a press release is the giving of the information in the same realm.
Don’t over work it or make it stuffy. If it is for the "Home Town Local Paper” and
you grew up in the areaq, keep it in that frame of mind.



Example of this:
HEADLINE FOR PRESS RELEASE:

HOMETOWN GAL SERVES UP A HELPING OF “CHICKEN SOUP” (actual head line in
a press release used by a writer doing her own marketing.)

The headline in itself gave hints as to what was going on. Do you see it?e If, you
have heard of the well known of series, *Chicken Soup for the Soul”, then you
know that the article that followed was about a woman who was being
published in one of their series and was getting the word out.

While it is not in the same line as a complete novel or work, it was just as
effective. The author then was interviewed by the small town paper, as well as
two of the larger town papers in her area. All because of ONE press release. The
human interest in the story had spread. Not only that, but the local book store
invited her to sign the book.

Imagine yourself, on a larger scale, doing this, with YOUR OWN BOOK! It can be
done.

Moving it into a larger scale press release would not be any more difficult. You
would add a review from another author or if you were able to get a good
critique from a reader’s site, add that to the press release.

There are many ways to add to the “foundation” of a press release that makes
them news worthy and eye catching. It is all in the details of them.

If you have a review that reads well, include it. You are a writer, use that to make
your press release work towards your favor. Write several and try them out on
whoever will listen.

ll. Make a List and Check It Twice.

BEFORE you send out your press releases:

*  Make sure that you know WHO you are sending them to and write their name
down next to the paper that they are addressed to. Knowing the name will
be handy. If not now then later.

* Make sure that you have double checked EVERYTHING about the release.

 Have you remembered the RELEASE DATE of the book?

* The Publishere

* The COST and type (Paperback or Hardcover or both?)

* Isthere a NICE picture of you with the release?

* Have you covered the information in an eye catching and
interesting way?

* Did you remember to breathe? (Just checking)



After you send out your press release:

* Give ample time for them to be received and follow up on them.

* Send thank you letters on results that you may receive, EVEN the negative
ones (Keeping you on their minds, remember.)

» Consider having a “RELEASE DAY GET TOGETHER” and remembering those
that gave you interviews locally. (one of the reasons for the names with the
list)

Ill. Keeping YOU on THEIR Mind.

NEVER FORGET TO SEND A FOLLOW UP LETTER. SEND FLYERS TO EVENTS. SEND
INVITATIONS TO BOOK SIGNINGS. IF YOU ARE INVITED TO SPEAK TO A GROUP
ABOUT YOUR WRITING OR HOW TO BECOME ONE...send a press release.

It is always going to be about LETTING THEM KNOW YOU ARE OUT THERE AND NOT
GOING AWAY.

Being HEARD is as IMPORTANT as being SEEN

|. Radio

Your eyes are not deceiving you. Radio is an important Media venue for
everything. If you know how to go about it, being interviewed on talk radio can
send your sales upward and onward.

My husband has spent HOURS in the man cave lining up interviews for himself on
talk radio shows, for the promotion of his book that is coming out soon. It can be
done.

So how does one do this. Well, | like to say that it is not without sacrifice and a lot
of lonely nights on my part, but since | am working on this packet for you and he
is down stairs doing his work, | will tell you that he is sharing his knowledge as well.

You can go to www.beginningwriter.com and find many links to the places and
things that he has used to line up interviews for authors. This site is free and is set
up by my husband, Mark Eller.

You should GOOGLE SEARCH all local radio stations in your area. Make, again a
list of these and get them, as well, a Media Packet ready.

Here is the difference however:

10



If you have never done a live reading or have never recorded yourself doing
one, practice up. You should have a sound bite. Make one and burn it to disc.
This should go intfo what | callan AUDIO MEDIA PACKET.

You can do this simply by recording over and over what you would do as a
synopsis of your book. | like to think of it as a “*commercial” of sorts. You can be
as creative as you want with this. Add music, sound effects to match your
reading, change your voice to match characters, whatever you think will sell
your book to the listener. It is the way to make the listener want to BUY the book.

Il. The Pod-Casting Era

We have entered into the era of pod-casting and if you have ever thought
about doing this, my suggestionis, GO FOR IT. It is a MARELOUS way to draw in
fans before you even get a book published.

However, be warned that it takes work. LOTS OF IT.

There are many books out there on how to do this. One of my husband’s
favorites is “Pod Casting for Dummies”.

| think that there is a series of these books for everything! However, arm yourself
well if you get into pod-casting. It takes time to perfect the craft, dedication to
do the work and it is HUGELY time consuming.

A good example of a Author doing a pod-casting show is available at
www.hellholetavern.com. Itis a Sci-Fi Fantasy Novel that was developed into a
show by a first time published author. However, you will note the way that it
evolves.

Two good things about pod-casting are that 1) it allows you creative freedom
and 2) it opens networking doors.

Marketing is also about networking. Other authors, publishers, pod-casters,
potential fans, and buyers of books listen to pod-casts. It is a good way to get
your work out there. Also, some shows are now looking for authors to feature, so
you can always submit your work to them for review.

This will allow you to have sound bites made, if you can’t do your own, with
sound effects in some cases, as well as have a review done and have some
things to have added to your Media Packet.

lll. A Novel Idea

There are several places on the net where you can review other authors’ books
and they will review yours. Swimming Kangaroo Books offers this, as does other
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sites on line. While you may think this is a waste of your time, having readers
reviews are imperative to your Media Packet.

As well as doing mutual reviews, this allows you to network with others. You never
know who knows who in the literary world and that person may be able to help
you in reaching new realms! NETWORKING is a MUST in Marketing.

YOU have to get out there and kiss some babies to make it in the literary world. It
is like being a politician, all about the future of your success.

One of the most amazing places that has been found to be a virtual networking
place on line is “SECOND LIFE”. | know, amazing righte

IF you have not been there or have heard of it and thought “NO WAY"....take
the time to check it out. They have “live” readings, meetings, venues for new

writers and some “well known" writers do their thing there as well. So it is worth
your time to go in and check it out.

National Review
|. How to keep your Marketing Packet on a National Level

Keep it professional, simple righte Wrong. If you don’t keep it up to date, fall
behind or get sloppy, it fails the test. So keep it updated. Don’t think that it
doesn’'t matter. It does and it will affect the success of your ability to sell books.

Update it with each event that you have, be it a reading, a signing, a review or
new book that you have come out. If you have a social gathering that has
anything to do with your book, invite press. Human interest stories are always nice
to add to the packet and look good on you!

If you make it to any list, that is positive, throw it on the lists in your packet. Keep
frack of the number of sales your books make. This is information that adds to the
value of your packet. Numbers add up and add to the interest one may take in
interviewing you or not.

Il. Making sound choices.

Your book is an investment, not only to the Publisher, but to yourself. Everyone
would like to make money, but no one more than you. Set a REASONABLE GOAL
with a REASONABLE time table.

Don't look at it like a “get rich quick scheme” because it is not for that reason
that you wrote the book. No one expected Harry Potter to take the author off
the public dole, which it did, was wonderful...but that is not a common
occurrence.
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Make good choices in where you will do book sales/signings. Don't expect to do
massive sales if you have done none of the leg work in getting the word out that
you have a book on the market. Success is earned and not given.

Ill. Meeting and Greeting those of Like Minds

Ask others where they have had the most success with their books, sales and
signings. Did they sell them on street corners, at flea markets, grocery stores?

What advise would they give to you, as a new authore Ask them if they have tips
that they would share? What were the worse places and the best to get results?
Don't be afraid to ask. The worse anyone can ever say is NO.

Have the same faith in your ability to Market your work that you did in writing it,
use that same conviction and it will be successful and so will you.

13



List of Places to have Book Signings

Local small independent book shops (Print the flyers up and put
them around town yourself-offer this and they will jump on it)

Favorite Coffee House(approach the owner and make a deall!)

Open Reading Night at Book Club (find out what clubs do what
genre of readings and get in there and offer yourself up!)

Contact Local Libraries

Used Book Stores (Many would LOVE to have the Local New
Writer to come to them!)

Local Grocery Stores (those that sell books and have them put
the signing in their sale ad!)

Laundry Mat (while | have never seen this one done, | have
heard of it.)

Conferences for things such as: Pod-Castings, Where you might
be speaking on something, Doing a guest appearance.

English Classes in Schools (Be a Speaker)
Career Days in Schools(Be a Speaker)

Depending on the Genre of book:
Science Fiction Conventions, Adult Conventions, Mystery
Dinners, Murder-Mystery Clubs, Etc.

And as always...DON'T FORGET TO LET PEOPLE KNOW THIS IS GOING ON!!!
11




(PUBLISHER’S NAME HE RE) Publishers Street Address
City, State and zip

Phone (XxXX) XXX-XXXX
Fax (XXX) XXX-XXXX

Press Release

Contact: (Your Name) FOR IMMEDIATE RELEASE
Phone: (xxx) xxx—-xxxx (your (be sure to fill in this
number) area)

(TITLE THAT IS EYE CATCHING)

(CITY AND STATE, THEN DATE): When writing a press release, say who, what, where, when, why,
and how in the first paragraph, if you can. Study your newspaper and notice how deftly most writers work
that type of information into the first paragraph of each article. In addition, it’s helpful if you remember the
following:

e Know your contact’s name, title, telephone, fax, and department.

e Mail or fax your release 10 days in advance of the release date.

HOW TO CUSTOMIZE THIS PRESS RELEASE

TO OPTIMIZE THE GRAY SHADING to work with your printer, click it, and then click Borders and
Shading on the Format menu. Click the Shading tab, click a new color or pattern, and then click OK.

Insert your company information in place of the
sample text, and change the header on page 2 (for

multi-page stories).



On the File menu, click Save As. In the Save as
type box, click Document Template.

To create future new documents from the template,
on the File menu, click New to re-open the

customized template as a document.

[Your Name]

[Street Address]
[City, ST ZIP Code]
[Current Date]
[Recipient Name]
[Title]

[Company Name)]
[Street Address]
[City, ST ZIP Code]

Dear [Recipient Name]:

Thank you for covering the release of my new book “[fill in book name]”.

I was so glad to get to share with you the (cover details about the interview) and thank
you again for taking the time to allow me the opportunity to introduce my first work to
the area!

I will be sure to send you an invitation to the first signing and media events to follow.

Sincerely,

[Your Name]
[Title of Book again]

cc: [be sure to get the name], Station Manager



